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Introduction | Intro to Harmony Training Guide 
This technical guide covers the SDS Harmony Data System layout and navigation, along with basic functions such 
as locating a consumer record requesting access to a consumer record (Inquiry), creating notes with attached 
documents.  

Learning Objectives… 
 Navigate through SDS Harmony 
 Identify the functions of the Consumer, Inquiry, and Providers Chapters  
 Review the tabs of the Consumer record 
 Identify the importance of Notes: how to add a note, attach a file and route it to 

someone else if necessary 
 Understand the functions of ticklers and how to work with them 
 How to create certified provider reports 

 
In order to use Harmony, SDS needs to ensure your identity is authentic.  To do this you will use your myAlaska 
account. You can create a new account only for this purpose, or you can use a myAlaska account you already 
have. You can create as many myAlaska accounts as you need. SDS will not be able to see any of your personal 
information on any myAlaska account you use for Harmony access, such as PFD applications. 
 

Provider User Requests Access to Harmony 
1. Your agency Access Coordinator will work with you to complete and submit a Harmony Data System 

Privacy and Security Agreement for Individual Provider User. 
2. You will receive an email confirmation once SDS has reviewed and accepted your agreement. 
3. Please complete myAlaska self-registration to DSDS Harmony. 

a. Go to My Alaska.gov  
b. Under Services for Businesses select ‘DSDS – Harmony Data System’ 

 
myAlaska Services for Business page 

http://dhss.alaska.gov/dsds/Documents/harmony/SDS_access_coordinator_agreement.pdf
http://dhss.alaska.gov/dsds/Documents/harmony/Harmony_security_agreement_individual.pdf
http://dhss.alaska.gov/dsds/Documents/harmony/Harmony_security_agreement_individual.pdf
https://my.alaska.gov/
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c. Select My Alaska from the Portal Dropdown list 
d. Click ‘Continue to Sign In’ 

 
Harmony SSO Portal selection page 

e. Login to your myAlaska account 
f. Redirected to Privacy Agreement 

 
i. Check the I Accept the Privacy Agreement box 
ii. Click Continue. 

g. Redirected to Harmony Self Registration page. 
4. Complete Harmony Registration Form. 

a. Your personal information. 
i. User Name = Defaulted to Email address from myAlaska. 
ii. Set First name = Your first name. 
iii. Set Last name = Your last name. 
iv. Set Middle name = Your middle name (optional). 
v. Set Date of birth = Your Date of Birth (optional). 
vi. Set Title = Your Job Title (optional). 
vii. Set Email address = Defaulted to Email address from myAlaska. 
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Harmony Access Registration Form 

viii. Set Work phone number 
ix. Set Work phone extension (optional). 
x. Set Mobile phone number (optional). 
xi. Set Supervisor name (optional). 
xii. Add additional comments (optional). 
xiii. Select your Work Position. 

1. ADRC Specialist 
2. Care Coordinator 
3. Independent Living Specialist 
4. LTC or General Relief Referrer 
5. PCS Services Coordinator 
6. STAR Coordinator 

b. Your Provider Agency contact information. 
i. Enter your Provider Agency Name 
ii. Enter the Provider Agency address 

c. Click Send Information. 

 

 Key Point 
Once an application is approved, the Position selected will give the user a default role. Not all Positions 
have the same default role associated to it. 
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Provider User Granted Access to Harmony Data System 
1. You will receive an “Access Confirmation” email  

a. Open email ‘Harmony Self Registration – User Activated’ 
b. Click “You can login here.” 
c. Log into myAlaska 
d. A new tab or window will open the Harmony application to the users My Harmony Desktop.  

 

Chapter 1 | Login, Roles, My Harmony 
Login  
Like most applications, such as email, you need to log in before you can access and enter information. You are 
working with Personal Health Information, it is critical that you create a complex password and guard it. It is also 
important to Sign Out of the program to protect sensitive information, rather than just stay logged in or closing 
the Internet browser. 
 
SDS Harmony users will use a custom Single Sign-On function. State employees have the ability to automatically 
login when connected to the state’s network. Certified SDS Providers also have a similar automatic login log in 
through their myAlaska account.  
 

Sign in to Harmony using MyAlaska login 

Once your Agency Access Coordinator has submitted your individual User Agreement and you’ve received the e-
mail invitation to self-register in Harmony you will see the portal after you’ve logged into your MyAlaska 
Account. 

 

Internet Browser Set-up for Internet Explorer 

The system will time out after 60 minutes of in activity in any window that is open. To avoid managing multiple 
windows and accidently timing out while working in the system you must set your Internet Explorer –Tools 
Menu, Internet Options Menu, Tabs Menu to “Always open pop-ups in a new tab”. 
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This should help to ensure you don’t forget an open SDS Harmony window that cause the system to log you off. 

Sign Out of Harmony 

When you are finished using Harmony, you should sign out. Then close your browser window. 
1. In the upper right corner of the screen, click Sign Out. 

 
Sign Out link 

User Roles 
A Role defines what you can see and do in Harmony (read-only, add, edit, and delete). Your assigned role is set 
to allow you to do your assigned job in the system. You may use more than one role for your work, so you’ll 
need to change roles, depending on what you’re doing in Harmony. 
 
A Certified Provider user will have access to 2 roles: 

1. User specific: Care Coordinator, PCA Admin (External), LTC Referral Specialist, etc.… 
2. Provider Search 

 
Roles limit access to sensitive information. If you do not see certain information, menus, options or fields, it may 
be because your role does not allow it. SDS staff roles are different then providers and they can often see 
options in the system that provider users do not. 
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Change Roles 

Most Providers who use Harmony will have access to the additional role of “Provider Search” 
1. In the upper right corner of the Harmony screen, click the down arrow in the Role section. 

  
Change Roles Area 

2. Select the role you want to switch to. 

 
3. Click Go. 
4. The screen will refresh and display the new role’s My Harmony screen. 

My Harmony  
My Harmony (chapter) is the first page you see once you are logged in to the Harmony application. My 
Harmony serves as a home page that displays panels of information about the records assigned to you. Some of 
this information includes ticklers to complete, notes to read, and appointments scheduled. These panels are also 
shortcuts to lists of records. 

Quick Search 

Quick Search works best when you’re looking for a specific record and you have a specific information you can 
filter by, such as a Consumer’s Last Name, Case No or Medicaid ID. 

Quick Search Bar 

My Harmony Screen Elements 

There are several parts of the My Harmony screen, as shown in the screenshot below. The number and type of 
columns and panels change depending on your Role in Harmony.  
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My Harmony  

1. Header, Sign Out, Role, and File Menu Bar 

The top of your My Harmony screen is a fixed area that will display wherever you navigate. Key features include 
the Sign Out link, Role, and File Menu Bar. When you are within a consumer file, the individual’s name and HDS 
number are located within this area. The File Menu Bar is the area where you will go to take action.  

2. Quick Search and Advance Search 

The Quick Search allows you to change what area of HDS you are searching in quickly. The Advanced Search 
page is helpful for using multiple filters to search for a specific Consumer. 

3. Chapters 

The tabs located below the search bar are called Chapters. They each reflect a different area in Harmony. You 
can see what chapter you are in by the gold highlight. Below is a summary of each chapter in the HDS.  

Chapter Definition 

My Harmony The home page that displays panels and queues of records in the system that are relevant to 
the current user, including notes to be read and a summary of the individual  CC’s  consumer 
caseload. 

Consumers Provides access to all consumers associated with an agency, including individual CC caseload.   

Inquiry The system “front door” area to request access to a Consumer record in order to submit an 
application or represent a consumer. 

Providers The Provider chapter tracks certification and licensing credentials, ID numbers, workers, 
services offered, service areas, and other types of provider information.  

4. Panels 

A summary of your case information is located below the My Harmony chapter within Panels. The left hand 
column shows summary panels for Consumers assigned to you. The right side, Inquiry column shows summary 
panels for people you have requested access to.  
Each panel contains one or more links with a count of related items. You can collapse or expand each panel to 
show or hide information by clicking the > in the top right corner of the panel.  
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***When there is no information to display the panel will disappear, with the exception of Alert Notes.  

Notes Panel 
The panel will disappear when there is no information to display, with the exception of Alert Notes. The Notes 
will remain in this panel until you mark them as “read”. When there is no information to display the panel will 
disappear, with the exception of Alert Notes. 
Note status of “Complete” end a Note string. Note status of “Pending” allow back and forth communication. In 
the example below, there are 14 unread notes. 13 are “Completed” and one is “Pending”. If there are no Notes 
with you as a Note Recipient that you have not already reviewed and dismissed, this panel will not display. 

 
My Harmony Consumer Notes 

Alert Notes Panel 
Currently Provider Users will not see any Alert Notes in this section. This is a locked default in the software 
product so the panel will always remain on the screen. 

Appointments Panel 
The Appointments panel is used to invite you to a CAT Assessment appointment that has been scheduled for 
one of your consumers. PCS Providers and Care Coordinators receive invites. If you ‘Accept’ or ‘Tentatively 
Accept’ the appointment you will receive updates if the appointment is changed. Once you have responded to 
the Appointment it will disappear from the list.  

• If you have no invitations to appointments this panel will not display. 

My Consumers Panel 
All of the people that are assigned to you on the Division Tab in their consumer record and/or on the Program 
tab will be listed here. The category of “active” indicates that they have an “active” division record. It does NOT 
mean they have an active Program. 

My Consumer Programs Panel 
The largest panel on your My Harmony page is likely to be My Consumer Programs. Many of our clients have 
multiple programs; PCS and a Waiver for example. Some of our clients have previously applied for or received 
services from other SDS programs; CCMC to APDD for example and that history is included in their Consumer 
Record. Therefore your My Consumer Programs total count will not be the same as your My Consumers count. 
There are over 45 program statuses available in the SDS Harmony Data System. Ranging from ‘Active’ to 
‘Suspend’. Most of them are self-explanatory and none of them require a Care Coordinator to take an action. 
They are available for your information and to provide transparency to the life cycle of the consumer’s program 
status. 
Some of the most common Program Statuses you may see are: 

• Request Application   
• Assessment Requested  
• Assessor Assigned 
• Assessment Scheduled -There should also be a corresponding Appointment reminder 
• Assessment QC 
• Assessment Scoring 
• LOC/LOS Determined -There should be tickler to begin this person’s initial Support Plan 
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• Active 
• Suspend  -SDS is awaiting a determination of some type. Medicaid, LTC, Incarceration  

 

 
 
You can open the Consumer’s Program Tab to see reasons why a program was Expedited, Suspended or Closed. 
Sometimes there are additional comments about why a program is in a specific Status. 
 
You should review this information often to see if one of your consumer’s programs has unexpectedly changed 
program statuses. This could be an indicator that something needs to be looked into. For example if SDS sends a 
registered letter and it comes back undeliverable, the program may be put into ‘Suspend’ status until we can 
locate the consumer. The CC or PCS agency Admin could then get in contact with the client, deliver the 
important information and verify any address changes. 

Chapter 2 | Layout and Navigation 
Introduction 
This chapter reviews the layout and structure of the Harmony Data System. It also gives instructions and tips on 
how to navigate within Harmony. Harmony is organized into chapters, tabs, pages, and fields. 

Tabs 
Chapters are organized into tabs. Tabs display lists of information. Tabs display rows of file folder tabs below the 
Chapter bar and the current record name and number: 

  
Consumer Chapter Tabs 

File Menu Bar 
The File menu is displayed throughout the system, located in the upper left corner of the screen. Other menus, 
such as Edit, Tools, Reports, Ticklers,and Word Merge may be displayed based on the area within the system. 
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This is the location where you’ll go to create or add records, close and save records and print, among other 
functions. 
Additional functions remain available under each option. Hovering above each item on File Menu bar will 
expand additional menus. Access to these are granted based on the permissions which are driven by roles. Some 
examples include and are not limited to: Save, Save and Close, and Print. 

 
File Menu 

When users scroll through a page in Harmony, the File Menu header is frozen so that users will always be able 
to access these File Menu functions no matter where the cursor is located on the page.  

• File: Contains the functions to add a new record or to view history changes to the data in view. 
• Edit: Provides the ability to make changes to the data included in the record. 
• Tools: Provides the user with additional functionality based on the page currently in view. 
• Reports: If a user has access to the Reports menu, click the menu and select the report and it will open 

in a new window 
• Ticklers: Provides the user with a list of “ticklers” or reminders generated for a specific Consumer or 

Provider. This menu is only displayed at a chapter level. 
• Word Merge: Contains customized Microsoft Word documents which “merge” in specified information, 

such as a client name and address. Often used for letters. Select the document to merge and it will open 
in a new window. 

Pages 
The Harmony system has three standard types of pages:  

1. List Pages 
2. Detail Pages 
3. Search Pages 

To work with a Consumer or Inquiry record, you must first search and select it using a search page. The chapter 
will load upon selecting the record. If it is the only record matching the search perimeters then it will 
automatically open the record. 

List Pages 

Most tabs in the Consumers and Providers chapters display a list page when selected. A list page works like a 
fixed search page that returns results automatically. The results on a list page are the records for the current 
Consumer or Provider in that information area. For example, the Consumer Notes tab displays a list of Note 
records entered for the current Consumer. List pages also display via many subpages. 

  You can sort each column in any List View Page by clicking the column heading, shaded in blue. 

 
Example of List Page 
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 Key Point 
If you have already opened a list from a My Harmony panel that opens a list in a separate window, and 
you’ve kept that window open, then additional lists views will load in that original window and will not 
open additional windows. The page tab should flash and change color when information is updated 

Detail Pages 

A detail page is a summary screen generally used to add or edit a record. Most detail pages contain a single 
vertical column of data entry fields with the field label on the left and the data entry field to the right.  

 
Consumer Demographics Detail Page 

Subpage Menu 

If a record has additional pages it, Harmony present a subpage menu to the left of the main detail page. The 
subpage menu consists of buttons that open list pages or detail pages for the related information. To select a 
subpage, click the subpage menu button. The current selected subpage is highlighted in orange. 

 
Consumer Plan Subpage Menu 
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 Note: Subpage menus only display when viewing/editing a record after the initial save; they will not 
display when first adding a new record. There are several instance when subpage menus appear after the main 
page or record creation has been saved. Most often are in the Inquiry Process, Updating Demographics and 
when creating a Waiver Support Plan 
 

Save and Close 
As you work with records, there are several options to save your work and/or close the file you’re working with. 
The File menu displays these options in the context of the task. In the screenshot below, the user is working in 
the Consumer Demographics screen, in the Address subpage. 

  

Advanced Search 
The Advanced Search page is a tool for searching and selecting a Consumer, Provider, or Inquiry record, and is 
the page that displays when a user clicks on one of these chapters. Search pages have two primary sections:  

1. Search Filters above, including a Search button 
2. Search Results below  

 
Provider Advanced Search 

Option Definition 

Save Save changes and keep the file open. Because the user 
is working in the Address subpage, the option is Save 
Address. 

Save and Close Save changes and then close the file. In the example 
above, the option is Save and Close Address. 

Close Close the file without saving changes. In the example 
above, the option is Close Address.  
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Search Filters 

Each search filter contains four parts: 
1. Filter Field: the data point to search on 
2. Operator: the relationship between the filter field and the value 
3. Value: the filter field answer to search on 
4. Connector: the relationship between this filter and other filters in the search 

 

Operators 

Each filter row includes an operator that defines the relationship between the filter field and the value: 

Operator Definition 

Equal To Returns records that match the entered criteria. For example, if <Last Name> is entered as “equal to” a 
specific person’s name, the Consumer records assigned to that worker will be returned. 

Begins With Returns records that begin with the entered criteria. For example, if <Last Name> is entered as “begins with” 
‘T’ the system will return records assigned to the worker having last names that start with ‘T’, such as Tester 
and Thomas. 

Ends With Returns records that end with the entered criteria. For example, if you search on <Last Name> “ends with” 
‘r’, you can retrieve records where a Consumer’s name ends in ‘r’, such as Tester. 

Not Equal To Returns records that do not match the entered criteria. For example, if a particular name is entered for <Last 
Name>, the system will return a list of records except those records for the name provided in the search 
criteria. 

Greater Than Returns records that are dated later than the entered criteria. For example, if <DOB> is entered as “greater 
than” ‘03/01/2015’, the system will return all records with a records whose dates of birth are after March 1, 
2015.  

Less Than Returns records that are dated earlier than the entered criteria. For example, if <DOB> is entered as “less 
than” ‘03/31/2015’, the system will return data for all records with a birth date before March 31, 2015. 

Contains Returns records that contain the entered criteria.  For example, if <Last Name> is entered as “contains” 
specific values in the person’s name, the Consumer Record(s) assigned to that worker with those values 
would be returned. 

Blank A record is returned where the selected field does not have a value in the field. 

Non-Blank Returns records where the selected field does have a value in the field. 

Connectors 

The connector options of “AND” and “OR” between multiple filters have the following effects: 
• AND tightens your search: only returns records that meets ALL filter criteria.  

Example 
Find Consumers where <DOB> is greater than (>) March 1, 2000 AND <DOB> is less than (<) June 30, 
2015.  This returns all reports dated between the two dates entered. 

• OR broadens your search: returns records that meet ANY of the filter criteria. 
Example 
Find records where <Last Name> equals “Jones” OR <DOB> = “June 22, 1998.” The system returns 
Consumer records with last name of Jones, regardless of date of birth, and also returns any Consumer 
records whose birth date is 6/22/1998 

Modifying Filters 

The Advanced Search page opens with default filters that have been set up for your role. Users can modify their 
search by adding, changing, or removing filters. The available filter fields are based on data points within the 
records you’re searching – attributes of Consumers, Providers, or Inquiries. 
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• Add a Filter: To add another filter to your search, click the green  button to the right of the bottom 
filter row. Then proceed to set the filter field, operator, value, and connector for the filter.  

• Change a Filter: To change an existing filter row, change any of the four filter parts as needed. 
• Remove a Filter: To remove an existing filter from your search, click the red x button to the right of a 

filter row. 
 

 Note: In addition to the search filters you apply, search results will be limited by the security settings of 
your role. For example: 

o External Provider roles, such as a Care Coordinator or PCA Admin, will only see search results for 
Consumers that are actively associated with.  

o SDS and ADRC roles have access to search on all Consumers in the Harmony system. 

Search Results 

Once you’ve adjusted your search filters, click the Search button to load or refresh your search results. The 
search results section of the Advanced Search page displays the results based on your search filter criteria in a 
table grid with columns of data points and rows of search results records. 

  
Provider Advanced Search Results 

 

Search Results Features 
• Sort: The results will be sorted by default on the column with a black triangle icon indicating sort 

direction: ascending (pointing up) or descending sort (pointing down). Here, results are sorted in 
ascending order on DBA Provider Name.  

o You can sort on a different column by clicking on the column header. 
o You can toggle to reverse the sort direction by clicking on the sorted column header again. 

• Count: The search results zone will display a count of records that match the filter criteria.  
• Paginated Results: Harmony is configured to return up to 15 search results at a time. When the results 

of the search exceed that limit, the search results section will identify which 15 records in the overall 
results set are displaying. 

 

You can increase the results per page by changing the default value of 
15 at the bottom of the page and then clicking one of the buttons.  
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• Results Navigation: When your search results in more than 15 records, you can navigate the “pages” of 
results using these four buttons at the bottom of the search results section: 

Button Description 

 

Jumps to the first set of results 

 

Jumps to the previous set of results 

 

Jumps to the next set of results 

 

Jumps to the last set of results 

When you find the right record in the results, click on that row to open that record and load the chapter. Now 
you can proceed to work with that record to review, add, or update information. 

Flyout Menu  
Some pages include flyout menus on the row level at the far right side of the columns. Flyout menus provide 
additional options for interacting with that record beyond just clicking to select it. Hover over the triangle icon 
to display a flyout menu, and then click to select a menu option. 

 
Inquiry Advanced Search Flyout Menu 

Field Formats 
There are several different types of data fields within Harmony, such as text boxes, checkboxes, date fields, 
dropdowns (sometimes called lookups) and search fields. 

Required Fields 

Required fields are always indicated by a red asterisk (*) 

 
Required Field  

Linked Fields 

Sometimes choosing a value in one dropdown field will filter or change the values shown in another dropdown 
field on the same page. This is indicated with a blue asterisk (*) to the right of the field. 

Date Fields 

Date fields can be populated in either of two ways. First, the user can simply type the numbers and Harmony will 
automatically format the field.  

Example: For this date field, the user typed: 01012016 
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The other option is to click on the calendar icon and use the calendar display. To select a specific date, simply 
click on the number after the correct month and year are chosen. 

  

Pre-formatted Fields 

Some fields are pre-formatted for certain types of data, like phone numbers. The user simply has to type the 
numbers and Harmony will automatically add the appropriate formatting such as dashes or brackets.  

Example: for this phone field, the user typed: 5555555555 

 

Multi-Select Fields 

Some areas of the application require you to select items from a list, and move them from one field to another, 
using arrow buttons. If you hover over one of the arrow buttons, a ToolTip is displayed that describes what the 
button does. In the screenshot below, the mouse was hovering over the button to move selected items to the 
right. 

 
Multi-Select Field 

Shift and Ctrl Keys 
• You may select more than one item when items are listed consecutively. First, press and hold the Shift 

key on your keyboard and select the first and last records in the group. Then, click the right-facing 
button to move all items to either the right or left field. 

• You can also select more than one item when items are not listed consecutively. First, press and hold the 
Ctrl key on your keyboard while selecting multiple items. Then, click the right-facing button to move the 
items to either the right or left field. 
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Entering Addresses (Places Feature) 
When you enter an address in SDS Harmony the Places feature links fields together and prefills or filters the 
options based on the perimeters you’ve entered. This is a national database that is quickly referenced to prevent 
users from selecting incorrect combinations. 
You must wait for the options to appear based in your entry and then select the correct one from the list. 

 
Blank Places Fields 

Entering a ZIP Code first will filter the other fields automatically, and if there is only one option, the other fields 
will pre-fill.  

 
Populated Places Fields 

 Key Point 
Addresses must be “Ended” and marked “previous” and the new one added instead of updating the 
existing address. This helps to maintain a history of addresses the consumer has used.  

Chapter 3 | Consumer Records 
A Consumer Record contains all the information about your client within organized tabs, such as their name and 
address, medications, diagnosis and their Authorized Providers and Support Plan details. 
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 Key Point 
Providers can only access a new consumer record after they have submitted an Inquiry requesting 
access and SDS has approved that request. 

Division 
The Division tab is used to capture data about a consumer with SDS. A consumer must have an active SDS 
Division record, before they can be associated to one of the state’s programs.  

 
Division Record 

Programs 
The Programs tab associates a consumer with an SDS program. Each consumer will have at least one program 
record. “Combo clients” will have a separate program record for each program in which they are involved. 
Program history also displays here. For example, if a person was involved with the CCMC Waiver and then 
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transitioned to the APDD Waiver, the past involvement in the CCMC Waiver program will continue to display as 
a program record that’s now closed.  

 
The Program status tracks a consumer’s stage in the program life cycle, as they move from application, to 
assessment, to planning, to authorization, and finally active or approved program involvement as a recipient. 
Program Status informs the My Consumer Programs panel on the My Harmony summary page. User should 
verify when program goes into “Suspend” status, that it is not affecting other programs. 
 
An IDD/ISW consumer will also have their Assessment Cycle noted in the Program Summary page. A CC can 
check here to determine which reapplication type to prepare next.  

 
Program Record 

Program  Description 

ALI Program Alaskans Living Independently  

APDD Program Adults with Physical and Developmental Disabilities  

CCMC Program Children with Complex Medical Conditions  

CFC Program Community First Choice  

DD Eligibility Developmental Disabilities Program Eligibility 

DD Registry Developmental Disabilities Program Registry 

General Relief General Relief Program 

IDD Waiver Program Intellectual & Developmental Disabilities Waiver Program 

ISW Program Individualized Supports Waiver 

LTC Facility Long Term Care Facility Authorization 

LTC ICF-IID Long Term Care Intermediate Care Facility for Individuals with Intellectual Disability 
Authorization 

Nursing Facility Transition Nursing Facility Transition Authorization 

PCA Program Personal Care Services  

TEFRA Program Tax Equity and Fiscal Responsibility Act (a Medicaid Qualifying program) 
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Notes 
Notes are used to submit Applications, Support Plans, Changes of Status and for Provider Users (CC or PCS 
Admin), to receive approvals, authorizations and other communications from SDS about a specific consumer. A 
note allows the attachment of up to 10 files in PDF, Microsoft Word® or Microsoft Excel®, images in jpeg, gif and 
tif formats. 
A note can be routed to other Harmony users as long as they are associated (have access to) the consumer. 
Notes that have been routed specifically to you (as a note recipient) appear in the My Harmony Notes panel 
There are 2 types of Notes: 

1. Consumer notes located through the Notes Tab on the consumers record. 
2. Plan or Inquiry notes located through the subpage of the Plan or Inquiry record.  

a. Plan Notes may not appear in the consumer record’s Notes Tab.  
b. Inquiry notes will be linked to the Consumer Notes Tab. 

Forms 
The Forms tab allows users to view, edit, and add system created forms pertaining to a consumer. Some forms 
are very large, have complex configuration and can have data pulled into another area or report. Forms can be 
limited to a specific role and can be assigned as a tickler.  
 
The Plan Expedite and/or a Request for Safeguard Funding for ISW forms are completed in the Forms tab of a 
Consumer Record. Care Coordinators will complete Plan Forms within a Plan record such as the Plan Details 
form. 

Plans 
The Plans tab is used to enter and track Person Centered Support Plans and PCA Service Plans. A Consumer will 
have a separate plan record for each plan period (year) and any amendments. If the Consumer has a PCS and 
Waiver they’ll have a different plan for each.  
The Plan Information page defines the Plan Program, Type, Status and Dates.  
• The Plan Forms page includes the forms for collecting additional details on the plan such as the Support Plan 

Details, Plan Questionnaire and the Request for Visit Exception.  
• Service Goals are tracked under Needs-Goals.  
• The Planned Services sub-page contains the services that are authorized within the plan.  
• Notes specific to this plan are added in the Plan Notes sub-page (some of these Notes are also available 

through the Consumer Notes tab) 
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Plan Information detail page 

 Key Point 
The Consumer chapter is designed to work on one Consumer at a time. Only one record should be open at a 
time. If you change consumers, any screens running the background may not be saved. 
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Providers 

The Providers tab is used to track all certified Service Providers associated with the consumer. Once a provider is 
made ‘Active’ on the consumer record, all system users assigned to that provider will have access to that 
consumer’s record. Closed Providers remain listed but no longer have access. 

 
 

Appointments 
The Appointments tab is used to track CAT Assessment appointments for the consumer. PCS Providers and Care 
Coordinators will receive an invite to the scheduled assessment. If you ‘Accept’ or ‘Tentatively Accept’ the 
appointment you will also receive updates if the appointment is changed. 

 
Appointment Record 
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Diagnosis 
The Diagnosis tab allows users to view the International Statistical Classification of Diseases and Related Health 
Problems (ICD-10) associated with the consumer the SDS Harmony data system. (Only SDS Staff can add to this 
tab) 

 
Diagnosis Details 

Medications 
The Medications tab is used to record information on the medications prescribed to consumers. SDS Assessors 
will capture Medications during the CAT appointment but not all of the information about the medication. Once 
Care Coordinators are fully in the system, they will fill in all the details and add any additional medications when 
they are prescribed.  Information on discontinued medications remains but does not print on the Support Plan. 

 
Medication Details 

Case and Professional Relations 
In Harmony Relations tabs allow users to view, edit or add data for legal representatives and professional 
persons who need to be associated with the consumer. 

 
Case Relations tabs 

• The Case Relations tab is used to track legal representatives. (Only SDS Staff can add to this tab) Once 
the legal representative paperwork has been sent to SDS they will be added to the consumer record. 
You may see previous case relations or providers listed here. These can be removed by request when 
the Support Plan is submitted. 
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• The Professional Relations tab is only visible to SDS Staff roles. 

DD Registry 
The DD Registry tab provides the user with a quick view of the consumers place on the DD registry. Some 
Consumers may have an active ISW but still be in waiting status on the DD Registry. 

• This is only available for consumers who’ve entered the registry or updated their DDRR since January 
2018 

 
DD Registry Record 

Chapter 4 | Reports 
Reports File Menu 
The Reports Menu is located in the File Menu Bar.  
Users often need to locate certified providers of service in specific areas of the state. Sometimes you just need 
to find the Medicaid ID # for a certified provider.  

 
1. Go to the Providers Chapter 
2. Click the Advanced Search Link 
3. The Reports menu should appear next to the File menu 
4. Select the Certified Provider Search Tool from the Reports menu 
5. Set your report perimeters 

a. Select the certified services  
b. The Boroughs you are looking for providers in 
c. What SDS programs the provider is certified to serve 

6. Click the View Report button in the upper right corner. 

7. You can download the report in a variety of formats by selecting this icon  
a. To create an Excel document that can be sorted, select the CSV format 

 
When users click the Reports menu a list of reports will display based on the role of the user. Select the report 
from the list and it will open in a new window or tab labeled “Production Report”. Most reports can be saved as 
a PDF. 
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Consumer Plan Reports 

The Person Centered Support Plan (formally the Plan of Care) is a report. The data that prints on the report is 
gathered from many locations in the Consumers Record including the Plan Details form. 
 
The Cost of Plan is an overview sheet, listing all the providers and the amount of services being requested. The 
report also serves to inform consumers of the total cost of the Support Plan. 
 

 
Person Centered Support Plan Report 
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Chapter 5 | Notes 
Introduction 
Notes are used to submit Applications, Support Plans, Changes of Status and for Provider Users (CC or PCS 
Admin), to receive approvals, authorizations and other communications from SDS about a specific consumer. A 
note allows the attachment of up to 10 files in PDF, Microsoft Word® or Microsoft Excel®, images in jpeg, gif and 
tif formats. 

Parts of a Note 
Each note includes several fields. The Note Type and a Note Sub-Type fields determine where a note is routed, 
so it’s important to select the correct options when you create a note. A table of Note and Sub-Types is 
included in the Appendix of this guide. 

Note Type 

A Note Type describes the note’s main subject. A common Note Type example is Change of Status.  It is used to 
notify SDS of a change to a consumer status or records.  

Note Sub-Type 

The Note Sub-Type provides more detail about the note’s subject and helps to categorize it for routing. For 
Example, the Sub-Types for a Change of Status note include: Admission/Discharge, Demographic Information, 
Legal Representative, Cognitive Capacity/Service Model, PCS Provider Transfer, and Provider Discharge of 
Services/ Closure. 

** There must a sub-type selected in order for you to save a Note. Notes without sub-types are view 
only and cannot be created with the role you are using. 

Description 

The Description area appears in the list view of notes and is where you should enter a statement of the purpose 
of this Note. Only 270 characters fit in this field and it is a good place to enter a list of the documents that are 
attached. 

Note Body 

The body of the Note can be very large. It should contain more specific details that SDS or Providers should 
review when reading the note. The body of the Note can be added too by other readers until the note status is 
set to ‘complete.’ 

Note Attachments 

Attaching document files to a Note allows signed applications or plans and supportive documentation to be 
added to the consumer’s record.  An attachment can be any documentation that is in an electronic form, such as 
a letter created in Microsoft Word®, a PDF of a signed application, or a nurse’s handwritten note that has been 
scanned into another electronic format.  
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Open a Note from My Harmony 
Notes are opened within the consumer record, or from your My Harmony Notes Panel. Notes that you are 
creating are listed as Draft notes. Notes you have filed and are awaiting action from SDS are listed as Submitted. 
Notes that have been acted on by SDS are displayed as Complete. 
** You may see older Notes with a Pending status. They are the same as Draft status. 

1. To open an unread consumer note, from My Harmony, in the applicable section, click anywhere in the 
Complete row. 
*If you do not have any unread Notes you will not see this Panel on your My Harmony page. 

 
Consumer Notes 

2. A list of notes is displayed. To open one of the notes, click anywhere in the note’s row. 

List of Notes 

3. More information that is included in the note is displayed. 

 
Note Details 
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4. Some notes include a menu of sub-pages displayed on the left side of the screen.  

 
Note Sub-Menu 

5. To close the note, click File – Close Notes. 

 

Create a Note 
To create a note, follow the steps below. 

1. Click the Notes tab in the Consumer’s Record.  

 

Notes tab in consumer record 

 

2. Point to the File menu and then select Add Notes.  
 

The Note Details screen is displayed. Required fields are noted with a red asterisk (*) next to them and must be 
completed before saving the record. Fields without a red asterisk are optional; however, it’s always a good idea 
to enter as much information as you have available. 
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Note Details 

3. Select the Program you are making the Note about (make sure to select CFC not the Waiver if your Note 
is about a CFC service) 

4. Select the Note Type and Note Sub-Type 
a. If you cannot select a Note Sub-Type, it means this is a Note you are not allowed to create but 

you will be allowed to view it if an SDS staff member creates it. 
5. Enter a short Description similar to an email subject line; include a brief list of any attached documents. 
6. Enter the body of the Note if there are any clarifying details you would like to communicate. 
7. Attach any files or documents. Scroll down to the Attachments section and then click Add Attachment. 

 
Note Add Attachment Section 

a) Click Browse to locate the file on your computer that you want to attach to the note. 

 
Attachment Browse Screen 
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b) Locate the file, select it and then click Open. 
i. In this example, the consumer’s ROI has been signed and returned. The user has 

scanned it to create an electronic PDF file. 

 
Computer file location  

c) File Name is a feature that allows you to rename a file so that it appears differently in Harmony 
then what it was originally named in your directory.  

d) In the Description field, type a brief description of the file. 
e) Select a Category. 

i. Select the appropriate Category based on the file being uploaded. 
ii. “C-“ means it’s a consumer type document 
iii. “P-“ means it’s a provider certification document 
iv. Approved SDS forms are listed  
v. Leave blank if there are no matching categories. 

 
Attachment File Brower screen 

 Key Point 
The note description is important! Over time, a record can include 100’s of notes. If descriptions are missing or 
inaccurate, the note needs to be opened to see what the attachment is. When the description includes a list of 
the attachments, it is displayed on the notes list view, so you can easily scan the list to find what you’re looking 
for. Or even user the Advance Search filter to locate a specific word in the description. 
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f) Click Upload 
i. To upload the file and then upload another file to the note, click Upload and Add 

Another 
ii. Only 10 attachments of 20.41 Mbytes each can be attached to one note. 

1. If you need to add more documents, just add another Note and enter “note 2 of 
2” in the Description line.  

g) A link to the file is displayed on the note. 
h) You can verify the file that’s been attached by clicking the link to open it. 

8. Once you’ve entered all the information into the note, change the Status to “Submitted” and then click 
Save and Close Notes from the File menu. 

 
Note File Menu- Save and Close 

 

Route the Note to Another Harmony User 
Harmony allows you to route the note to one or more users. When the user receives the note, it is displayed on 
their My Harmony chapter, in the Consumers or Inquiry Notes panel. The HDS user must have authorized 
access to the Consumers Record to view the note, otherwise the Note will not open. 
 This is rarely done for Specific SDS staff, only in specific situations and when requested by SDS staff. 
 
Before saving the note, follow the steps below: 

1. Scroll down to the Note Recipients section and then click  (the ellipsis). 

 
Note Recipient Search 

2. Type the last name (or the first few letters) of the Harmony user in the Search by Last Name field and 
then click Search. 

3. Select the name from the list. 

 
Quick Search Screen Results 
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4. The Harmony user is added to the Note Recipients section. 

 
Add Recipient 

5. Repeat steps 1 – 4 to add additional note recipients. 
6. Click File – Save and Close Notes. 

  Key Point 
When the recipient opens the note, the status is automatically changed to Read. 
It is not necessary to route a note to a specific user. Most notes will be reviewed based on the program and 
status they are in. Avoid routing to a specific Harmony user unless necessary. 

Edit a Note 
You can edit notes you created that are in a Draft status. Once you change a status to “Submitted” your note is 
filed and cannot be changed. A note also cannot be changed if it’s set to Complete. (SDS often does this to 
indicate they’ve reviewed the Note) 

  
Edited Note 

 Key Point 
When the Note Status is Submitted or Complete, the fields are dimmed and you cannot edit them. You must 
create a new note in this case. 
 

Filtering a list of Notes 
Any list view of records can be narrowed for specific information using the Filters area. The following are helpful 
filters to locate specific types of information: 
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List of Notes from the Consumer Notes Tab 

Note Type Filter  

This filter will help you locate a specific Note Type. All the results will include the Notes with that specific Note 
Type.  You can narrow your search by adding an additional filter of Note Sub-Type, click the green plus to add as 
many filters as you need. This will requires you to know the right subtype (in this case approved) and have the 
item listed. 
 

This is an example of finding an IDD LOC Determination.   
• NFLOC determined waivers use Note Sub-Type ‘Notice Sent-Approval’ 

 

Filter for Attachments 

This filter is helpful for finding Notes with attachments. These usually contain: 
• LOC Letters 
• CAT Reports 
• Approved Support Plans 
• Applications 
• Documents that have been mailed to your client 
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Mark a Note as Read 
Notes specifically routed to you will appear in the My Harmony > Notes panel and will continue to display 
there until you manually mark the Note as “Read.” 

Once you are done with a Note, you may ‘Mark as Read’ from the Tools menu to remove it from the 
Unread Notes panel. This does not removed it from the consumer’s record. 

1. Check the box at the end of the Note line when ready to delete it from this list 
2. Go to the Tools menu 
3. Click Mark as Read 
4. Notes that were checked will be deleted when the My Harmony screen refreshes 
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Chapter 6 | Ticklers 
Introduction 
A tickler is a reminder to do something, such as submit a renewal Application or a Support Plan for a consumer. 
You should review your Ticklers daily, but do not rely on them to let you know when something is due.  You are 
required to maintain your own record keeping system as part of your Conditions of Participation. Harmony 
creates ticklers automatically based on dates entered in the consumer record for LOC/LOS and Support Plans.  

Locate and Open a Tickler 
Ticklers are displayed on the My Harmony Chapter. You may receive several ticklers throughout the day, so it is 
important to check often for new ones. The screenshot below shows that there are 59 consumer ticklers. These 
are reminders to do something for or that an action has been taken or will be taken for one of the people you 
serve. 

1. From My Harmony, locate the ticklers under the Consumers column.  
2. Click anywhere in the ticklers row to display a list of consumer ticklers. 

 
Consumer Ticklers 

3. To open one of the ticklers, click anywhere in the row. 

 
List of Consumer Ticklers 

a. Details about the tickler or reminder are displayed.  

 
Tickler Description 
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b. A Tickler can also send you directly to complete an action on a consumer like beginning the renewal 
application or begin an initial plan after LOC is determined.  

 

Using Ticklers Daily– 
The HDS creates ticklers automatically. You may receive several ticklers throughout the day, so it is important to 
check often for new ones. 

Sorting List Views 

List View screens allow you to quickly retrieve a desired record.  If the desired record is not displayed on the 
initial list view, you can click on one of the buttons at the below the list to scroll through the returned records. 

All HDS data that is displayed in a List View can be sorted by ascending or descending order by clicking on the 
column headers in the list view. 

You can also modify the number of records returned in the List View by entering the desired number in the 
“Retrieve [15] records at a time” field at the bottom of the screen and then clicking on one of the record search 
buttons (i.e., First, Previous, Next, Last). 

  
 

Act on a Tickler 

When you open a Tickler that has an associated action in the HDS it may take you directly to that action point in 
the consumer’s record. For example we clicked on the Tickler named “LOC is Approved, Begin working on the 
Plan” and the system took us to the consumer’s record> plans tab. 

 
We can clearly see that the Support Plan from this Tickler that was dated 1/19/18 has already been 
submitted. So it can be marked ‘Complete’ by using the flyout menu available in the Workflow Wizard 
task area. Then using the File menu select Close the Workflow Wizard. 

 

 
 
When opened some Ticklers just show you a message that repeats the Tickler Name like this: 
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Use the flyout menu at the end of the tickler line to ‘Cancel’ or ‘Complete’ when you no longer need the 
reminder. 

 
Managing your ticklers should help you to manage your work load but DO NOT rely on them to direct your tasks 
all the time. You must maintain your own client management tools in order to meet regulatory deadlines. If you 
receive a transfer client close to when their reapplication or renewal Plan is due you may not receive the ticker. 
Therefore you will be late. 

Dismissing Ticklers 

1. To start open your Ticklers list, then click on the ‘Date Due’ twice to sort them by the oldest due date. 

 
2. Open the Flyout menu by hovering your mouse pointer over the triangle on the far right of the tickler 

line. The action menu for this specific tickler will appear. Possible actions can include: 
• Cancel   
• Reassign -only send a task to someone who also has access to this consumer 
• Edit 
• Complete 
• View Consumers Record -use to verify you have already completed the task 

3. Select either ‘Cancel’ or ‘Complete’ to remove the Tickler from your list. SDS does not track what you 
do with your ticklers. They are there simply to remind you something may need to be done or let you 
know that something (like a LOC or Support Plan) has been approved or completed. 

 Key Point 
If you cancel a tickler this does not cancel the need to complete the task if it has not been done. Ticklers are 
reminders. Like alarms, just because you turn them off doesn’t mean you don’t have to get up! 
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View Future Ticklers 
If you are looking for ticklers that have a due date in the future, uncheck the Apply Alert Days Before Due 
and click Search. The list view page will refresh and present a list of the ticklers and their due dates. 

 
Apply Alert Days Before Due tickler list view 

Chapter 7 | Inquiry Creation 
Introduction 
The Inquiry chapter serves as the “front door” for requests to work with a specific consumer.  
To file a program application, a Certified Provider must first be associated with a person (consumer) by making a 
Provider Request Inquiry and attaching a Note including the client’s Release of Information (ROI) and other 
supporting documents. Provider Users must also make an Inquiry for Consumer’s who wish to transfer from 
another provider. (Provider Request-Transfer) 
The Provider User will select the Program Que their potential new client (Person Seeking Supports) is applying 
for and associate the Agency they work for prior to entering minimal demographic information. SDS will review 
the information and match it to any Consumer Records we may already have for the individual.  
How to create a Provider Request Inquiry is part of your role based training. The following is brief summary as 
there are slight variations depending on how you will be serving the person. 
Almost every action in the HDS starts by going to the File Menu and then selecting Add _____.  In the case of 
Inquiries we begin by going to the Inquiry Chapter, hovering over the File menu and clicking on Add Inquiry. 
Then a detail screen appears for you to begin the inquiry process. 
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Once the Program Que and the inquiring Agency has been selected and the file is saved, the potential 
consumer’s basic information must be collected.  

Program Queue 
When users navigate to the Inquiry chapter, a queue displays records based on default filters. The queue is 
configured differently for state users and providers users. State staff will monitor this queue daily, for new 
provider request submissions. 

 
Inquiry Queue 
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Creating an Inquiry Request  
Participant Information 

The Participants sub-page is used to document demographic details for the Person Seeking Supports (Potential 
Consumer). Minimal demographic information is required to be entered here. AND for most Program 
applications the Medicaid # and Eligibility code must be added to the Identifiers sub-page. 

 
Participants sub-page 

From the Add Participant menu select ‘Person Seeking Supports’, complete the name, gender, DOB, age and 
primary language. Then go to the file menu and save. 

 
Basic Demographics 

Select the participants sub-page Identifiers 

Identifiers 

On the Identifiers sub-page go to the File Menu to Add Identifier. Select the Identifier Type of Medicaid and 
enter the consumers Medicaid Number, and then the eligibility code in the Comments box. Verify the Active, 
Display and Primary Boxes are checked, then go to the File menu, and select Save and Close. 
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Inquiry Note 

To process the Inquiry, the UNI 16 – Release of Information (ROI) must be submitted to SDS.  
1. Create a Note through the File Menu – Add Note  option 

 
2. Set the Division to ‘IR’ 
3. Do NOT change the Note By 
4. Do NOT change the Note Date 
5. Select the Client Name from the Participant drop down list 
6. Note Type: Consumer Documentation 
7. Sub-Type: Release of Information 
8. Add a brief Description of the documents you will be attaching to this note. 

a. Depending on the consumer other documents may be needed such as an Appt of Care 
Coordinator.   

9. Click Add Attachment and browse your computer for the files you need to attach. 
a. You must select a category matching the type of document you are attaching 

10. Change the Status to Submitted  
11. Use the File menu to Save and Close Note 

 

Submit the Inquiry 

1. Return to the Inquiry Sub-Page 
2. Update the Inquiry Status to ‘Submitted’ 
3. On the File menu select Save, Check-in and Close Inquiry 

Checking-In or Checked Out Inquiry  
After you are finished entering the Inquiry information, several options exist to save, close and/or check in the 
record. These options are found on the File menu. 

1. Click File and then select one of the options that are defined below.  
2. Only Checked-in inquires in the Submitted Status can be reviewed and approved by SDS 

  
File Menu – Save, Check In and Close Inquiry 
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Save Option Click this when you want to 

Save Inquiry Save changes you have made to the record and keep it open and checked out. 

Save and Close Inquiry 
Save your changes and close the record but do not check the record in. 

SDS will not be able to approve this request until you Check it In 

Save, Check In and Close Inquiry Save your changes, close the record and then check it in. 

Check in Inquiry Check the inquiry in and keep the record open. 

See Who has a Record Checked Out 
If a record is locked and you need to work with it, you can easily find out who has the record checked out. 

1. Click the Inquiries chapter. 
2. Search for the inquiry. For more information, see Search for Records. 
3. The person who has the record checked out is listed in the Checked Out To column. 

 
Inquiry List  

Check Out an Inquiry Record  
1. On the far right of the list, point to the Fly-out Menu  and then click Check In Item. 

a. To verify that the record is checked in, point to . You should see Check Out Item. 

 
Inquiry List 

Chapter 8 | Provider Records 
Introduction 
A certified provider has an organization record in Harmony. Most providers in Harmony are service provider 
agencies, but individual Care Coordinators are also tracked as providers. The Providers chapter includes 
functionality to track certification and licensing credentials, ID numbers, workers, services offered, service areas, 
and other types of provider information.  
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To review your Provider record select the Providers Chapter then click the search button. 

 
All of the Agencies you are associate to will be listed, just click to open the Provider Record. 

Provider 
The main provider record contains the identification, location, and contact information. 

 
Provider Record 

Credentials 
The Credentials tab is used by SDS to manage the provider network and to capture critical information about 
important credentials that establish whether a provider is qualified to render services. The SDS Harmony system 
contains two types of credentials: certifications and licenses.  
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Provider Credentials Record 

Services 
The Services tab is aimed at capturing the services that a provider would offer to the community. Services are 
established in Harmony using the Service Code Utility and then each service is linked to the program or provider 
using the Services tab. A consumer has to be enrolled with a program/provider before services can be recorded 
in authorizations or activities for a consumer. 
 

 
Provider Services 
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Workers 
The Worker Tab shows Harmony Workers that SDS affiliated with your agency. This is not a full list of employees. 
This list can include CCs, owners, and Harmony provisioned staff.  

 

 

Consumer Tab 
The Consumer Tab shows all the consumers the agency currently serves. If you are a Care Coordinator you can 
view your individual consumer list by going to your provider record and look at this tab. 

Linked Providers 
The screen will show you any agencies or organizations that have a certification relationship with the provider. 
Especially helpful to determine the oversight agency for a Family Hab home, if there is one. If you are a Care 
Coordination Agency you should see a list of the certified CCs that work for your agency. 

Service Area 
The Service Area tab is used as a repository for information about what areas the agency/provider may serve in 
the community.  

 
Service Area data 
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Glossary 
Term Definition 

3rd Party 
Review 

The 3rd Party Review tab in the Consumers chapter is used to track communication via notes 
between SDS and Comagine Health when outside review is needed to complete a 
consumer’s level of care determination. This is part of the Material Improvement Review 
Process (MIRP). 

Inquiry  

The “front door” for requests to work with a specific consumer. A Provider Request must be 
made in order to initially associate the Certified Provider User with the person (consumer) 
so a program application can be made. Provider Users must make an Inquiry for Consumer’s 
who wish to transfer from another provider. 

Actions The Actions tab in the Providers chapter is used to track and monitor disciplinary actions 
taken by SDS or DHCS Residential Licensing on a provider resulting from negative outcomes 
of a compliance review or an investigation, a provider’s failure to renew certification or 
licensing, or a referral for an action by an outside entity. Actions may lead to formal 
enforcement actions, sanctions, or fines, as well as appeals from the provider subject to the 
action. 

Advanced 
Search 

A search page is used to select an entity. Advanced Search pages allow the user to search 
using multiple filters and display the contents with default filters for the most common 
search scenario. Like a list page, a search page has filters at the top, a search button in the 
middle, and search results below.  
The Advanced Search page is the gateway to loading a chapter. Users click to select a record 
from the search results to open it and load that record as the entity for the chapter.  
Examples include Consumer Advanced Search, Provider Advanced Search, and Inquiry Queue 
Advanced Search. 

Alert Note A Harmony feature to highlight critical information on a consumer or provider by displaying 
a note immediately in a pop up window every time a user selects that entity. A note displays 
as an alert if the note status = ‘Alert’. 

Appeals 

The Appeals tab in the Providers chapter is used to document when a provider appeals a 
decision, ruling, or notice that they are out of compliance. A provider has the right to appeal 
the finding(s). SDS staff can add and update appeals, associate them to actions, and monitor 
the status. 

Appointments The Appointments tab in the Consumers chapter is used to track consumer assessment 
appointments. Provider users can be invited to appointments, and invitation responses can 
be tracked. 

Attachment 
A file attached to a note on a consumer, provider, or inquiry record. A note can contain up to 
five attachments. Users can designate an attachment file name and select an attachment 
category. 

Authorizations 
(Auth) 

The Authorizations (Auths) tab allows a user to pre-authorize a consumer to receive specific 
services from specific providers. Each authorization is associated with a specific provider and 
date range. The service(s) that provider is authorized to deliver are entered under the Auth 
through the Auth Service subpage. SDS is not currently using this Tab. External providers 
will not be able to see it. 

Case Relations 
The Case Relations tab in the Consumers chapter is used to track family members, 
advocates, emergency contacts, and other contact people for a consumer. 
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Term Definition 

Categories The Categories tab in the Providers chapter is a tool to classify the various kinds of provider 
records in Harmony. Categories can be used to automatically assign relevant services to the 
provider as part the certification approval process.  

Chapter 

Chapters are the core workspace areas in Harmony. Examples include Inquiry, Consumers, 
Providers, Inquiry, and Reports.  
The Consumers and Providers chapters are organized into tabs. The Inquiry chapter omits 
the tabs and navigates directly to the Inquiry page and subpages. The My Harmony chapter 
is organized by columns of widgets that navigate to targeted list pages and queues. The 
Reports chapter displays a list of all summary reports available for the current role. 

Check 
Out/Check In 

Check Out/Check In is a Harmony feature used on Inquiries to limit edits to an Inquiry record 
to one user at a time. To edit an Inquiry, a user must check out the record. When the user is 
finished, they should check in the Inquiry. 

Close 
A file menu option to close the current window without saving any changes. The Close menu 
option will bring the user back to the previous window and refresh that window. 

Consumer An entity record for a person who is an applicant for or recipient of services. In the 
Consumers chapter, users work with one Consumer record at a time. 

Consumer 
Module 

The Consumer Module tab in the Consumers chapter is used to grant the consumer and 
authorized contacts access to log in to that Consumer’s record in the Consumer Module 
application. A representative for each consumer on the DD Registry is required to log in to 
the Consumer Module and complete an annual DD Registration and Review form. 

Credentials The Credentials tab in the Providers chapter is used by SDS to manage provider certifications 
and by DHCS Residential Licensing to track Assisted Living Home licenses. Certification 
credentials are distinct by certification service and indicate the applicable programs.  

DD Registry 

The DD Registry in Harmony is a wait list feature used to track consumers on the DD Registry 
waiting for IDD Waiver or ISW programs. The entire DD Registry is accessible from My 
Harmony > Tasks. If a Consumer is on the DD Registry, their Registry record is accessible 
from their Consumer record in the Consumers chapter > DD Registry tab. 

Detail Page A basic type of screen in Harmony used to add or edit a record. Most detail pages contain a 
single vertical column of data entry fields with the field label on the left and the data entry 
field to the right. After a record is initially saved, the detail page displays a subpage menu to 
the left, if applicable. 
The Detail Page is also referred to as an Edit Page.  

Directory Info 
The Directory Info tab in the Providers chapter contains settings that control whether a 
Provider record is published to or excluded from the Access Point online directory.  

Division Divisions in Harmony represent major lines of business; for example, “SDS” is a distinct 
Division from “ALL” (Assisted Living Licensing). The system requires that Consumers and 
Providers be active in at least one Division to be considered active in the system. Consumers 
must be active in the SDS Division before they can be associated with a Program.  
The Division is also known as Fund Code. 

Edit User account permissions to update/modify to the data in a record.  

Entity A core record in Harmony that functions as the centerpiece of a chapter. Examples include 
Consumer, Provider, and Inquiry. 
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Term Definition 

Experience 

The Experience tab in the Providers chapter is used by agencies to manage their provider 
network.  Critical information about important background and experience is tracked, which 
establishes whether a provider (or a worker associated with a provider) is qualified to render 
services. 

Fair Hearings The Fair Hearings tab in the Consumers chapter is used to track appeals and fair hearing 
process information. 

File Menu 
A list of options for user actions on a List Page or Detail Page. Options vary by page; 
examples include: Add New, Save, and Close. The File Menu bar can include other menus 
such as Tools, Reports, and Word Merges. 

Forms Forms in Harmony are data entry screens specific to Alaska SDS. Examples include the CAT 
Assessment and Level of Care Determination. The Forms tab is available in both the 
Consumers chapter and Providers chapter and displays records entered for the current 
Consumer or Provider through a Harmony form. 

Inquiry 

The Inquiry chapter is used for tracking system “front door” interactions including requests 
for information from an ADRC, prescreening, program referrals, and requests from Providers 
to access to a Consumer record in order to submit an application. The Inquiry Advanced 
Search page can be filtered by work queues based on program. Inquiry records identify a 
Person Seeking Supports that can be copied to create a new Consumer or link to an existing 
Consumer to facilitate Provider access. Once access is granted, the Provider can apply for 
and coordinate services in the system.  

Linked 
Providers 

The Linked Providers tab is used to track formal relationships between Providers. Examples 
include Care Coordinators associated with Care Coordination Agencies and rendering Group 
Homes and Family Habilitation Homes operated by or contracted with Certified Billing 
Providers. 

List Page 

A basic type of screen in Harmony used to display a list of records in a particular information 
area. A list page functions like a search page with preset filters that display the results 
automatically. Most list pages allow the user to modify the filters and refresh the lists.  
When a user clicks on a record in the list, that record opens in a detail page in a separate 
window. 
Also referred to as a List View or Grid. 

Monitor The assignment of a State Staff Worker to a specific Provider record for certain 
responsibilities related to certification, licensing, or compliance. 

My Harmony 
The system home page that presents panels and queues of records in the system that are 
relevant to the current user, including assigned Tickler tasks, Notes to be read, and 
Consumer caseloads. 

Note A note is used to communicate with other agencies and/or workers or for moving a process 
to the next step. Notes can be tracked in several areas in the system, including Inquiries, 
Consumers, Consumer Plans, and Providers. 

Note Recipient 
Notes functionality that allows a user to route a Note to one or more workers to prompt 
them to read and review the Note. Note Recipients will see Notes routed to them on My 
Harmony, and the system tracks if the Recipient has read the Note. 

Note Type and 
Sub-Type 

Notes are used to track a wide variety of information, and Note Types and Sub-Types are the 
categories for classifying Notes. 

Open 
To load a page in Harmony. Usually refers to loading a Detail Page to view or edit a record by 
clicking on the row for that record in the results of List Page or Search Page. 
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Term Definition 

Panels Widgets on the My Harmony home page that contain a header and a breakout of line items 
by type or status with a count of related items. My Harmony panels provide at-a-glance 
counts of key information like assigned Ticklers, Notes to be read, and Consumers on a 
caseload. Panels are also links to access lists of records that are included in the counts. 

Participant A record for a person associated with an Inquiry. Examples include a Person Seeking 
Supports, an Involved Person in a Central Intake report, a Reporter, and other Contacts.  

Plans The Plans tab in the Consumers chapter is used to track Person Centered Support Plans and 
Personal Care Service Plans. Plans are specific to a program and a service period date range. 
Consumers have a separate Plan record for each renewal cycle or plan amendment. Plans 
can include Planned Services, Needs and Goals, Forms, and Notes. 

Primary Worker 
A Worker assigned to a Consumer on a Division or Program record. Primary Workers can 
receive tickler tasks and reminders for their assigned Consumers.  

Professional 
Relations 

The Professional Relations tab is used to track Consumer’s Care Coordinator & Back-up CC, 
any PCS Agency Contacts and ALL Medical Providers. 

Programs 

The Programs tab in the Consumers chapter is used to track a Consumer’s involvement in a 
formal Program. The Program Status field is the key indicator of the Consumer’s current 
status in the stages of the program life cycle across processes for application, assessment, 
planning, active service engagement, renewal, and closure.  

Provider A Provider is a core record in Harmony that represents an organization. The Providers 
chapter includes functionality to track certification and licensing credentials, ID numbers, 
workers, services offered, service areas, and other types of provider information.  

Provider 
Associations 
Tab 

The Provider Associations tab in the Consumers chapter is used to connect a Consumer to 
any Providers involved in their case, such as Care Coordination Agencies, PCA Agencies, and 
Medical facilities. An active Provider Association is used to grant external Provider agency 
workers access to a Consumer’s record to submit applications and coordinate care. 

Provider ID 
Numbers 

The Provider ID Numbers tab in the Providers chapter tracks official identification numbers 
for the current Provider, such as Medicaid IDs by Provider Type, NPI, and PVN. 

Quick Search 
A shortcut search tool alternative to Advanced Search designed to find a record using a 
single key search filter such as Consumer Case No or Inquiry ID.  

Record An entry in a table in the Harmony system database. Harmony List Pages and Search Pages 
display lists of multiple records, whereas Detail Pages display the fields within a single record 
for viewing or editing. 

Reports 
Reports are tools for getting data out of the system. Harmony includes standard reports as 
well specific reports built for Alaska SDS. Reports may display data from a single record, such 
as a form, for the purpose distribution or signature, or combine information across records. 

Required Fields A field on a page must be completed before the page can be saved. Required fields are 
designated with a red asterisk. 

Reverse Status 

A File menu option to reverse the status of a record that has been saved with a status of 
“Complete” or “Approved,” which locks the record as read-only. Reverse Status is used when 
a record needs to be modified after it has been completed or approved. Permissions to 
reverse status are limited to select roles, including supervisors.  
Also referred to as Reverse Disposition. 

Role A Role is a system profile in Harmony that defines a user’s security permissions and available 
functionality necessary to perform job duties. 

Save A File menu option to save changes on the current page but keep the page open. 
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Term Definition 

Save and Close A File menu option to save changes on the current page and also close the page. Upon close, 
the system will navigate the user back to the previous screen. 

Service Area The Service Areas tab in the Providers chapter is identifies the geographic locations served 
by a Provider. 

Services The Services tab in the Providers chapter identifies the specific services or procedure codes 
that a provider is eligible to deliver to recipients, as well as any specific service rates for that 
provider.  
Services in the Consumers chapter can be added to plans. 

Subpage 

An information area under a primary record. Subpages are displayed in a page menu on the 
left side of a Harmony screen with the primary record as the top page in the menu. Clicking 
on a subpage typically displays a list page of the records that are associated under that 
primary record. Examples include Planned Services under a Plan, Inquiry Participants under 
an Inquiry, and Consumer addresses under Consumer Demographics. 

Tab An information area with a chapter. Tabs are displayed in rows across the top of a chapter 
screen, above the list page area. Clicking on a tab brings the user to a list page of the records 
in that area for the current, selected entity in the chapter. 

Tickler 
A Tickler is a system-generated to-do task or message reminder. Ticklers can be scheduled 
based on process timelines such as a prompt to submit a renewal application or plan, or 
triggered by data entry events such as the submission of an application or plan for review.  

Unlock Record See Reverse Status.  

User 
A user account authorized to log into Harmony. Every user must be linked to a Provider 
Worker. 

Word Merge A Harmony feature to generate an output form populated with system data via merge fields 
within a template. Word Merge is typically used to generate notices or letters. Word Merge 
templates are pre-configured to merge specific data points and are generated via the Word 
Merge File menu and via Workflow Wizard tasks. After Word Merges have been generated, 
they can edited in Microsoft Word, printed, and saved as note attachments in Harmony in 
PDF or Word format. 
Word Merge also refers to the resulting output. 

Worker The Workers tab in the Providers chapter tracks the individual staff members at a Provider 
or State organization. Workers may or may not also be system users.  

Workflow 
Wizard 

An automated feature in Harmony to prompt the user with a set of tasks or reminders that 
pop up in a separate window when triggered by a specific data entry event. Each task in a 
Workflow Wizard is a tickler and remains on the user’s tickler list on My Harmony, until it is 
completed. 
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